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National Geographic TOPO! Demo 
 
A. Getting started 
1.) Open TOPO! by double-clicking on the icon. 
The initialization screen will appear. 

 
 
2.) Next a welcome screen will pop up.  Start with a new map. 
You can have this screen come up every time you open TOPO! or you can uncheck the 
box that says, “Show this welcome screen every time TOPO! starts. 
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If you had “Start with a new map” selected, a US map will pop up. 
3.) Click the state you are interested in working with (e.g., Idaho). 

 
 
You will see an overview topographic map of Idaho draw.  
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Read the top bar to see that this is Map Level 1 of 5.  Level 1 is called the Reference 
Map. 

 
 
Just below the blue bar you will see drop down menu titles and a variety of buttons in a 
toolbar.  We will cover most of these. 
4.) Click on the zoom tool which looks like a magnifying glass. 

 
 
5.) Zoom into Boise by clicking on Boise.  Click again.  Now you should be at Map level 
3 of 5.  Notice that the blue bars states level 3 has a resolution of 1:500,000. 
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6.) Click again to Map level 4.  Notice we are now viewing 1:100,000 scale maps. 
 

 
 
7.) Click one more zoom level near Park Center Blvd. to show the 1:24,000 scale map 
(the same resolution as a 7.5 minute USGS quad map). 
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8.) Right mouse click on the map.  A pop-up tells you the map scale and magnification. 

 
Map level and magnification may be changed quickly this way.  Keep in mind the zoom 
tool changes map level which will take you from a course to a fine resolution (more 
detail, more contour lines).  Magnify Map just zooms you into the map at the resolution 
that is set.  Its like putting your face closer and closer to a paper map.  It doesn’t give you 
more detail necessarily because the resolution is only as good as the scanned paper map. 
 
B. View Menu 
Now that we are zoomed into our location, we will go through some of the drop-down 
menus and buttons.  Click on View to see the list of items available.  Its logical to start 
with Preferences and Settings but before we do that, let’s take a look at some of the view 
defaults that are “turned on” for this project.  A view is active when it is preceded by a  
grey  box (and may have a check mark).   
1.) Review Defaults 
a. The first one to notice is Overview Maps. 
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Overview maps are two maps on the right side of your main window.  They both use the 
Map level 5, NG Reference map background.  The top map shows the small area you are 
currently viewing at the 1:24K scale.  The bottom map uses less magnification to show 
the vicinity of the area of interest similar to the area chosen at 1:500K. 

 
 
You can turn your overview maps on or off in the View menu. 
 
b. The next view item that is turned on is Shaded Relief.   
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This is what the map looks like with topo map draped over a shaded relief map. 

 
 
If shaded relief is turned off, the map will look like this.   

 
 
 
Q: Why would you turn off shaded relief?   
A: There may be times when you want to print a map in black and white or photocopy a 
color map and shaded relief may distort contour lines on the map. 
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c. Street Overlays are also turned on.   

 
 
Take a look at the map.  Notice road names are showing.  If I hover the cursor over an 
unlabeled road, a label pops up for those roads as well. 

 
 
Are your roads on?  If not, click Street Overlay.  You have optional settings for the 
display. 
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d. Lastly we have Toolbar and Status Bar turned on. 

 
 
Mentioned earlier, the Toolbar is located below the drop-down menu items at the top of 
the map window.  I may refer to these tools as buttons throughout the demo.   

 
 
The Status Bar displays coordinates and elevation in the bottom right corner of the map 
window for wherever your cursor is positioned. 

 
 
Now we will go through the other View options.   
2.) Click on Preferences and Settings 
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There are many settings to adjust in this dialog box.  Click on Units and expand the 
subcategories to set preferences for Coordinates, Distance, and Elevation. 

 
 
Click on Coordinates and change the display setting to Degrees, Minutes, Seconds and 
the map datum to NAD83/WGS84.  Click OK. 

 
 
Notice as your cursor hovers over locations, the coordinates are displayed in the status 
bar in lat/long: degrees, minutes, and seconds. 
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Go back to View | Preferences and Settings.  You can change the Distance and 
Elevation measuring to the units you prefer to work in. 

 
 

 
 
Printing/Exporting preferences offer many modification choices.  Click on GeoTIFF 
Export.   

 
 
A GeoTIFF is a georeferenced .tiff image.  That means unlike an image that is not 
georeferenced (like a .jpg perhaps), it is tied to a location on the earth.  The ability to 
create geotiffs is one of the most useful applications of the TOPO! software.  This means 
.tiff images created here can be brought into ArcMap and used with other GIS data.  I 
will show you that at the end of this demo.   
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Let’s set up the preferences for GeoTIFF.  Keep the default setting of No compression.  
Check Optional Metadata Files of .tfw and .prj.  Choose the Projection and Datum 
settings UTM and NAD83 (this setting should match your other GIS data). 

 
 
Under Tools you can set Traveling and Compass preferences on your own. 
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Under GPS you may set your Receiver Type, Connection, Time setting and Waypoint 
Display.  I will show the use of a GPS receiver toward the end of this demo. 
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You can also explore options for Shaded Relief on your own.  The Data Folders setting 
gives you the opportunity to redirect TOPO to look on your hard drive for maps.  When 
the external hard drive is connected to your computer, you should have no problems 
viewing all the maps at the various scales.  If there is an occasion where you don’t want 
to (or can’t) travel with your external hard drive, you can copy folders to your hard drive 
instead and this setting points the software to look in the location you indicate. 

 
 
Next is a setting for Automatic Updates.  I don’t know if those are included in our NPS 
contract but it doesn’t hurt to try it. 
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MapXchange is a site that has free downloadable, up-to-date trail and recreational maps 
you can open, edit and save.  See http://www.nationalgeographic.com/topo for more 
information on mapXchange. 
 

 
 
3D is a useful (and fun) tool in TOPO.  Accepting the defaults is fine. 

 
 
3.) The next drop down item under view is TOPO! Product Setup 

 
 
This window shows you the serial number for the NPS contract license with National 
Geographic.  This is good to know in case you want to install the software on another 
NPS computer. 
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4.) Next let’s look at the 3D Map View. 

 
 
Your screen will split and show you the 3D view of the location of your cursor.  A red 
arrow shows the view direction.  Adjust the tilt and the elevation.  Spin the location.  We 
will create a route later to view a fly through.  To turn the 3D image off, click the 3D 

button.    
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5.) Next View item we will explore is Print/Export Area.   

 
 
A red box will form around the area you are “zoomed in” to and that indicates the print or 
export area.  On the right you have tabs for Print, PDA, Disk, and Clip.  Disk is the 
default and actually means save to disk.  Click Save Map. 
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Here you can choose what type of file to save to.  Remember we set our preferences for 
GeoTIFF and here is where you can save to that file type.  Name your file. 

 
 
Next click on the Print tab.  Many options to change here.  I will demo of a print later.  

 
To turn the print box off, click the Print/Export button.  
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6.) Next click on Grid in the View menu. 

 
 
A grid can be added to your map view and your printed map.  Keep the default settings 
for Lat/lon but change the grid line to a more visible line. 

 
 
A lat/long grid will appear on your map.  Put your cursor on a corner to see the 
coordinates displayed in the Status Bar below. 
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7.) Hotspot Magnifier gives an overview map of a chosen area on the main map. 

 
 
Click on Hotspot Magnifier and then on a location on your map to view a hotspot map 
in the upper right corner of your map window. 

 
 
8.) Click on the Find menu item. 
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Choose Utah as your state.  Choose Cities and Towns and type in Cedar City.  Find Now. 

 
 
Click on the city name and notice the overview maps.  Click Go. 

 
 
You will automatically pan to Cedar City, UT. 

 



National Geographic TOPO! v. 4.2.3                     1/11/2007 Page 22 of 46 

Now let’s search for parks in CA.  Choose California and Parks – City, State and 
National.  Click Find Now. 

 
 
Click on Lassen Volcanic National Park to see overview maps and then click Go. 
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At 100% magnification, its hard to see the park.  Right-click to change your 
magnification to 33% by right clicking on the map. 

 
 
We are going to create a map now so let’s add a lat/long Grid. 

 
 
Choose Print/Export Area. 
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See the red print area box on your map?  Click on the Print tab and then on the More 
Options button. 

 
 
Click on Marginalia.  Give your map a title.  Make sure Grid Labels are checked. 

 
 
Click on Magnification.  Choose Magnify or reduce maps to exactly fit 1 printed 
page.  This insures the area your have chosen with your red box will print on the size 
paper you choose. 
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Click on Additional Settings and change the page orientation to Landscape.  Click on 
Page Setup. 
 

 
 
Make sure the printer is set to Landscape also.  Click on Printer.  If you have PDF, 
choose it as your printer.  If not, you will need to choose a printer you have access to (not 
an option today). 
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Here is what a printed map will look like.  Notice the scale bar, title, and north arrow.  
All that is missing is author and date and all the elements of GSTOP (Geospatial 
Standard Operations on Incidents) have been met in this map.  The lat long grid is also 
printed with labels along the margin. 
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Let’s do one more search in CA before moving on.  View | Find.   

 
 
This time choose More Choices… and forest. 
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Type in Stanislaus and Find Now.   

 
 
Now type in national for name and Find Now.  All the National Forests in CA are listed. 

 
 
This can be helpful, for instance, if you are unfamiliar with the Forest Service lands in 
CA.  Can you think of other searches that might help you prepare for the places you are 
dispatched to? 
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9.) When you open the Coordinate Locator tool the coordinates that are displayed are 
for the center of the map.  The Coordinate Locator tool allows you to center your map 
to a set of given coordinates in Degrees, Minutes, and Seconds.  Keep in mind that the 
coordinate type can be changed in Preferences and Settings to Degrees, Decimal 
Minutes, Decimal Degrees or UTM Easting and Northing. 

 
 
If you use the Compass tool first to place an anchor point on the map, you will also get 
direction and distance to that center point.  We will use the Compass tool again in just a 
few minutes.   
Note: To reverse this process (i.e. get coordinates for a point on the map) either hover the 
cursor over the point or create a Waypoint (this tool will be covered shortly).  
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10.) The last menu item under View is Legend. 

 
 
Use your cursor to hover over USGS map symbology to find out the meaning. 
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C. Tools Menu 
Lets take a look at the Tools dropdown menu next.  We have used the Zoom tool already.  
Click on the Centering and Traveling tools to practice using them on the map.   
1.) Next click on Notes and Photos. 

 
 
With this tool you can annotate the maps with custom photos, notes, links to websites and 
documents.  When you place a note on the map, the note is displayed in the notes pane 
and as an icon on the map.  A single note may contain text, photos, and a link.  TOPO! 
can link any digital photo to a map. 

 
 
Notice the Notes and Photos button is active.  Click a spot on the map. 
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In the dialog box below you can type a Note.  Clicking on the Photo button, you can 
browse to and attach a digital photo. 

 
 

 
 
The Note is listed in the directory below and a note icon appears on the map. 

          
 
To turn off the directory pane, click on View and turn off Content Viewer. 
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2.) Next click on the Symbol tool.  Click somewhere on your map to add a symbol.   

                     
 
Change the symbol to a style that you prefer.  Click on Location. 

 
 
This is the current location of the symbol.  You can edit this if you like and the symbol 
will move on the map. 

 
 
Add some symbols to your map. 
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If you don’t like where you put your symbols, you can delete them.  File | Delete 
Contents.  Choose Symbols.  Notice the other objects you can delete from here. 

          
 
3.) Click Tools | Text. 

 
 
By default the elevation will be your text.  You can change this to anything you like 
though.  You can add as many text boxes as you like to your map.   

               
 
4.) Next choose Tools | Route 
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Use the tool to freehand draw a route.  The route window pops up when you are finished.  
You can Name your route, find out the length, or change the style.  Click on 3D Fly-
Over. 

 
 
Red arrow on the right shows the path of your route and 3D image displays on the left. 

 



National Geographic TOPO! v. 4.2.3                     1/11/2007 Page 36 of 46 

 
Right-click on the route to get the dialog box back up.  Click Build Profile.   

 
 
See elevation profile below.  This can be useful to when trying to determine view 
obstructions. 
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Simply hover your cursor over the route line and distance (in this case mileage) is 
displayed in a pop-up window. 
 

 
 
Right-click at a point along the route where you would like to split it into 2 routes.   
Click the Split in 2 button. 
 

 
 
Hovering the cursor over each segment will display the length of that line. 
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Finally, create a GPS Route… 

 
 
This dialog box helps you create the route (made up of individual waypoints).   
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5.) Moving on to the Compass tool.  Click on Tools | Compass.   

 
 
Click a location on the map (anchor) and a second location.  You can Name this vector 
and modify its style.  Notice the display of length and direction.   

      
 
You can also Build a Profile to determine elevation and/or view obstructions. 
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6.) Click on Tools | Waypoint.  Click on map to create a waypoint. 

 
 
You can rename the waypoint here.  Notice the Datum is consistent with how preferences 
were set early on.  A message or comment can also be inserted here. 
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The waypoint is displayed on the map with label and coordinates. 

 
 
You can Import waypoints, tracks and routes from your GPS to your TOPO! map.  You 
can also Export waypoints and routes up to your GPS receiver from your map.  This is 
done by directly connecting the GPS to the computer that is running TOPO! or can be 
done with GPS .txt files that reside on your hard drive.  You can also do real-time 
tracking of GPS location.  Mark Current GPS Position will store your location as a 
waypoint on the map.  Setup Automatic Tracking gives you three options for how you 
want your track displayed and recorded.  

 
 
I will now demo upload and download with a GPS. 
 
C. Info 
The last menu is Info.  The help document is fairly thorough and should be used often. 
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They even have a section called “For People Who Don’t Read Manuals” that covers the 
basics to get you started.  No excuses! 

 
 
D. GeoTIFF export and use in ArcGIS 
1.) Pan/zoom to an area in Lassen National Park.  Use the 1:100K map scale and make 
sure you are at 100% magnification. 

 
 
2.) Click on Print/Export Area from the View menu or the Toolbar. 
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Red box should appear across map and Export Area is shown.  Click on Disk tab and 
Options button. 

 
 
3.) Double check GeoTIFF Export settings.  Choose UTM, NAD 83. 

 
 
4.) Click on Save Map… 
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Browse to folder on your hard drive, name file, save. 

 
 
Check to see the files that were created on your hard drive.  You will need to know the 
location so you can add them to your ArcMap project. 

 
 
5.) Open ArcMap and a new Map Document.  Add Data. 
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The image will draw in your data view. 
 

 
 
Right-click on .TIF in the table of contents, and look at Properties.  The Source tab 
shows Spatial Reference as a projection of UTM, Zone 10N and datum of NAD83.  
This is the same projection and datum as other LAVO GIS data.  
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Here is an example where mines, springs and campgrounds were added to the data view. 
 

 
 
NOTE:  You may see shifts in data (i.e. things don’t line up perfectly) when using 
1:500K and 1:100K topo GeoTIFFs.  In most cases, park data was digitized at a scale of 
1:24,000 or better (or collected with GPS).  Using the 7.5 minute maps will get you the 
best results for small format maps (e.g., 8.5x11) as long as the area of interest isn’t too 
large and makes the contours unreadable. 
 
 
 
 
 
 
 
 
 
 
 
For questions regarding TOPO! software or this document, please contact Kathie Hansen, 608-263-7689, 
kathie_hansen@nps.gov or Doug Stephen, 303-969-2947, doug_stephen@nps.gov.  


